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Welcome to the March/April edition of my monthly Final Cut
Pro newsletter!

The goal of this newsletter is to provide information helpful to
the professional user of Final Cut Pro. This newsletter publishes
each month. Past issues are not archived, however, key articles
are posted to my website for your reference. All software
references are to Final Cut Pro 5 unless otherwise noted.

Please invite your friends to visit my web site --
www.larryjordan.biz We now have over 100 tutorials to help
you get the most out of Final Cut Studio!
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Tip: How to read this newsletter

One of the things I've noticed over the years is how soon
people read this newsletter after it's published. Easily 50% of
my readers read each newsletter within 36 hours of its
release.

Which is great and, frankly, enormously gratifying. But here's
a tip that | suggest you consider. | try hard to make each
issue as accurate and clear as possible. But, sometimes,
mistakes happen and | correct them as fast as they are
pointed out; generally within a day or two.



So, make it a practice to come back to the newsletter after a
few days. By then, any errors will be fixed and you can print
a copy for your records. | flag all changes with the word
Update.

By the way, if you spot a mistake, please let me know.

[ Goto top ]

Finally! Back-issues of
Larry's Final Cut Newsletter now available!

You've been requesting them for years. So, now, I've created
PDFs of all the back issues to my newsletter!

Two CDs -- one for each year -- with more than 560 pages
of tips, techniques and secrets.

CD #1: The 2004 back issues, including the very
rare first three issues. 240 pages of tips and
techniques covering Final Cut Pro 3, 4 and HD. This
CD includes many tips that have never again been
published. Each issue is a PDF file, fully searchable
and stored on a CD. $29.95. Click here to order.

CD #2: The 2005 back issues. 324 pages of tips
and techniques, with hundreds of screen shots,
step-by-step instructions and lots of reader mail.
These issues cover Final Cut Pro 4, HD, and 5 and
related applications. Each issue is a separate PDF
file, ten PDF files in all, suitable for printing and
stored on a CD. $29.95. Click here to order.

Or buy both CDs for $49.90 and save $10.00! Click
here to order.

By the way, you can see the entire range of training materials we have
available by clicking here:_http://www.larryjordan.biz/products.html.

[ Go to top ]

The DR Group and Larry Jordan team
to discuss a workflow for editing 24-frame projects

If you are in the Los Angeles area, this Tuesday, March 21,
starting at 7:00 pm, Larry is hosting a discussion of 24-frame
editing workflow at the DR Group.

Whether you are shooting 24-frame DV, HDV, P2, XDCam,
HDcam, Varicam or D5, if you are trying to make sense of
how to shoot 24-frame projects, edit them in Final Cut, and
output them for either SD or HD distribution, you need to be



at this seminar.

Registration is only $49.95 and includes presentations and
discussions from Lowell Kay, president of the DR Group, Jon
Thorn, AJA Project manager, Joe Faissal, on-line editor at the
DR Group and hosted by Larry Jordan.

Everyone attending will receive a free 16-page workbook and
lots and lots of answers to their technical questions.

I'm very excited about this seminar and look forward to
seeing you there.

Click here for more info: http://store.thedrgroup.com/24frwosel.html
[ Goto top ]

Article: What I've learned about HDV

During my recent seminar tour, | had a chance to show many
of you how to capture, edit, conform, and output HDV within
Final Cut Pro.

However, as frequently happens, teaching goes both ways - |
learned a great deal from your questions and comments. Now
that the seminar is over, | wanted to share some of my
conclusions about working with HDV.

First, HDV can create some very cool pictures -- especially
when you need to shoot HD video on an extremely low
budget. However, HDV also has significant limitations that
may, for some, outweigh it's cost savings.

HDV Strengths

For a relatively small amount of money, you can shoot an HD
picture. You also have a variety of frame rates to select from,
including 23.98, 25, and 29.97. Some cameras offer
additional rates beyond these three. And, the default aspect
ratio for HDV is 16:9.

In brief, HDV's strength is its low-cost, HD images.

HDV Weaknesses

However, on the negative side, the weaknesses of HDV are:

e The HDV image is 1440 x 1080, which does not
precisely match either the 720p or 1080i format.

e HDV is enormously compressed, creating the possibility
of significant motion artifacts when the camera is
moved, or zoomed, quickly. HDV uses MPEG-2
compression, the same as a DVD.



e This compression groups several pictures into a "group
of pictures,” called a GOP, rather than each picture
being it's own entity. 1080i HD groups 15 images into
one GOP. 720p groups 6 images into one GOP.

e This GOP method of compression means that HDV is not
accurate for timecode or frames when capturing or
outputting. (Editing HDV inside FCP is frame-accurate,
however.)

e HDV uses extreme color sampling, resulting in very, very
poor color keying, color correction, or compositing
results. (HDV uses 4:2:0 color sampling, the same as a
DVD. Here's an article that explains it in more detail.)

e HDV renders take about six times longer than DV. This
is actually a result of rendering the larger HD image,
versus an SD image; still, this will take longer than you
expect.

e HDV needs to be conformed, or rebuilt, into a consistent
GOP structure before it can be output to tape or
exported to a file. This conforming can take an
exceedingly long time. (For instance, conforming a 30
second sequence consisting of five shots, took over 10
minutes on my PowerBook. Conforming a complex hour-
long sequence could take several hours on a G-5.)

e HDV can only use Print to Tape, not Edit to Tape, due to
the timecode inaccuracies of HDV.

For these reasons, I am no longer the fan of HDV that | used
to be. What I've discovered is that we need to separate how
we CAPTURE the image from how we EDIT the image.

Using HDV for capture

HDV is an inexpensive way to capture HD images, provided
you are not doing any chroma-key or color work. If so, HDV
is the wrong format to use because the compression process
removes almost all the color information from an image. And
once the image is recorded to tape, the color can not be
rebuilt into being better than HDV.

If color or motion quality are important, you are far better off
shooting in DVCPro-HD. This codec, which takes about 4
times the disk space of HDV, uses significantly better color
sampling, compression and image quality.

Using HDV for editing

Based on what I've learned during these last several weeks,
here are my new criteria:

e If money or disk space are more important than time or
color, HDV is a good choice.

e If color or time are more important than money or disk
space, HDV is not a good choice.



What I'm recommending to my clients now is that if they
choose to use HDV for image acquisition (again keeping in
mind the problems with color and motion artifacts), they
should not capture HDV into Final Cut via FireWire, instead
they should convert from HDV to DVCPro-HD during capture.

(DVCPro-HD is one of the native formats of Panasonic's P2
camera.)

This requires an HD capture card, from companies like AJA or
Blackmagic Design, to do the cross-conversion on the fly
during capture.

DVCPro-HD provides the following benefits:

e Frame-accurate timecode during capture

Color sampling of 4:2:2 (at least 4 times better than
HDV)

No time lost to conforming

Can be edited on slower computer systems

Support for both 720p and 1080i images
Frame-accurate edits when laying back to tape

Capturing an HDV signal to DVCPro-HD requires:

e A camera that shoots DVCPro-HD natively, such as the
Panasonic P2, or...

e An HD-SDI connector on your camera or deck, such as
the Canon XL H1, or...

e HD component video out of your deck or camera,
running into an HD SDI converter from AJA, Miranda or
others.

The idea is to take the HDV signal, convert it to HDSDI, then
use your capture card to convert it into the DVCPro-HD
format for editing.

Here's another interesting idea. The Canon XL H1 has an
HDSDI port on the camera. If you record to a hard disk, such
as the FireStore, directly from this port, you can record in a
much less compressed format that HDV itself. Plus, you
bypass the entire capture process because your file is already
digital on the hard disk.

This means you can use an HDV camera for image
acquisition, yet record image quality far superior to HDV.

Now, using either the P2 or Canon XL H1 in this way opens
up the whole issue of how to deal with tapeless video. And |
have major problems with all the current solutions proposed
by Panasonic and others for archiving footage that did not
originate on tape.



For now, I only recommend tapeless recording for those
images that do not need to be archived for long periods of
time. My hope is that we will see more robust solutions from
a variety of vendors at NAB this year.

This whole process of shooting and editing HDV is very much
a format in transition -- and archiving is only one of the
major issues still in need of a better solution than exist
currently.

Still, 1 wanted to give those of you thinking about working
with HDV some options to think about as you strive to get
more work done and still maintain quality.

As always, | invite your comments.

Update: This HDV article generated a lot of contrasting
comments that | need to include in the current issue.

Graeme Nattress corrected me on HDV image size:

Larry, you wrote: "The HDV image is 1440 x 1080,
which does not precisely match either the 720p or
1080i format."

And neither does anything else even remotely
affordable. To get 1920x1080 you need to go to D5
or HDCAM SRI!!l HDCAM is also 1440x1080 (as is
most broadcast HD) and DVCProHD is 1280x1080.

Just think of 1440 as "anamorphic" (which it isn't
really) and you'll be fine. It's a non-issue, just non-
square pixels.

720p HDV is, of course 1280x720, which is what it
should be, square pixels. DVCproHD is 960x1280,
which again, is reduced.

Larry replies: Sigh... Wasn't HD supposed to REDUCE all this
format confusion. Thanks for the correction, I'll stop worrying
about image size.

Gardner Reynolds writes:

My only comment [on your HDV article] is the Z1
captures (if you know what you are doing) some
smoking images in any mode and is great to have
in the bag with other DV cameras. | agree it's a
format in transition but at least a camera in that
price range gets us started and warmed up on the
HDV platform. Thanks for the good articles.

Tom Wolsky agrees:



You might want to restate it when you write: "The
HDV the compression process removes almost all
the color information from an image."

I don't think it's accurate to say it removes almost
all the color information from an image. You make
it sound like it's going to practically desaturated. It
sounds as if the color rendition of HDV is very poor,
which is just not so. The color reproduction on most
HDV cameras is outstanding. HDV is not, | don't
think, substantially more difficult to chroma key
than DV, or chroma keying DV in PAL, which uses
the same color space.

Graeme Nattress provides a technical perspective:

[This color compression is] no more extreme than
DV (chroma for 4 luma, just in a different pattern).
Interlaced 4:2:0 is nasty, but this, as always only
effects chroma resolution, not quality. You shouldn't
see chroma sampling causing colour correction
problems - it's the excessive compression that gets
in the way here. And remember, HDCAM is 3:1:1
with only 1 chroma for 3 luma, so hardly much
better :-(

Tom continues:

You might want to explain how convert from HDV
to DVCPRO HD during capture. | didn't realize that
AJA and Blackmagic Design can convert to DVCPRO
HD. | don't see anything on their web sites to
indicate that they can capture to DVCPRO HD. They
have DVCPRO HD hardware acceleration and output
support, but | think they capture to uncompressed
HD. Big fast RAID drives. You're not in the HDV
league at all any more. This is the old use DV for
acquisition and then bump to uncompressed route.
Great if you have the bucks and your production
has the budget.

Larry replies: | just called tech support at AJA and confirmed
that they can convert HDV to DVCPRO HD in real-time using
their Kona 2 or Kona 3 capture cards.

Tom goes on:

As for exporting for DVD, | wouldn't downconvert
on export, but export a self-contained native HDV
file and have Compressor do the SD MPEG-2
encoding. The H.264 I'm sure works well but it's
probably really, really slow as all H.264
compression is quite time consuming. Then doing



another pass for MPEG-2 into DVD seems like an
extra long step.

Larry replies: My point is that when you are working with
HDV, you need to allow time, lots and lots of time, for
conforming. Conforming must occur whether you are
outputting to a QuickTime movie or to a video tape.

On the issue of whether converting from HDV to DVCPro HD
is a good idea, opinions diverged. | respect Graeme too much
to ignore his comments:

Graeme Nattress writes:

[Should you convert HDV to DVCPro HD?] No.
Never! Why? Adding compression on top of
compression is just bad. DVCproHD is way too
compressed. It's full of artifacts even straight of a
varicam. To add that compression on top of HDV
just makes a mess.

Answer - edit HDV native - it's easy on a decent
mac, and then just change the compression right at
the end of editing to "uncompressed”, do a final
render before going out to master tape. Again,
you'd never use HDV as a master - even one
compression back to HDV looks awful.

Only use DVCproHD if that's what you shot, or are
going back to DVCProHD tape. If you're recording
live from SDI, uncompressed HD, or PhotoJPEG
75%, are much superior.

Ed Yost comments:

Up until two weeks ago | was working on the DVD
documentaries for a very high profile film in which
all the behind the scenes footage and most all
interviews where shot in HDV. As the film
progressed the DVD producer

started to add NTSC footage shot on digital beta,
NTSC DV, and DVCPro HD 24p. The project became
an incredible mess and still is.

Unfortunately many of these producers pretend to
be know-it-alls and don't really take advice when
given. Sure wish they would take your seminars.

Larry replies: Thanks for all your comments. I'll update this
as more come in.

[ Go to top ]

Converting HDV to a standard def DVD



Following on this discussion of HDV, Lee Burrows writes:

I would like to subscribe to your newsletter and
wish |1 had known about your newsletter when |
encountered my own HDV to SD DVD issues.

I recently found a different solution that produced a
higher quality result than the one talked about here
that | thought I would share. | found that running
the footage back through the deck to convert the
HDV to DV gave me not very good quality for my
final compression of DV to SD DVD.

Here is what | did to go from HDV sequence to SD
DVD and it held up pretty well.

I exported my HDV sequence from FCP by
exporting via QT conversion in the H.264 codec.
Yes, | know its designed for true HD but it handles
HDV the best. |

even let it resize my sequence instead of doing it in
compressor to 720X480 however looking back it
might be a little better letting compressor resize it.

I did many tests and this came out the best from
an HDV sequence. | tried everything from HDV to
animation codecs, to bringing it out of my FCP
edited sequence back to my Sony HDV deck and
back in with a down conversion to DV 720X480 and
all had similar results of either bad artifacting or
strobing or field issues in the graphics. This codec
did it.

Try this and see for yourself, but if you are working
in an HDV 1080i sequence and need an SD DVD
this is the way to go...SO FAR! I'd still like to see
the quality [get] better and like to see the quality
[get] better from Blackmagic NTSC-Jpeg, DV, etc...
codecs to DVD but have yet to come up with
something that I'm happy with.

Larry replies: Lee, thanks for sharing your technique. I'll let
you know if anyone reports a better way to convert from
HDV to a SD DVD MPEG-2 file.

[ Goto top ]

Technique: Explaining the Video Processing menu

This technique was suggested by Bourne Ace, who wrote:

Larry 1 am having trouble understanding the Video



Processing tab of Sequence Settings.
Could you help me out?

Larry replies: There are some little known settings inside
Final Cut that can materially affect the final look of your
sequences. When | mention these during my classes, I've
discovered there is a lot of confusion about what these do, so
here's a more detailed explanation.

Your preference settings control what happens when you
create a new sequence. However, once a sequence has been
created, changing your preferences has no effect. To change
the settings of an existing sequence, you need to open the
sequence in the Timeline and make sure it's active.

cfects_Tools _Wind

Render =
Render All [
Render Only » 2

Settings...

Then, go to Sequence > Settings.

Sequence Settings

Mame: [5egquence 1

Ceneral ' Videa Processing ' Timeline Options ' Render Control || Audio Outputs |,

- Codecs which do not support ¥CbCr |
Always Render in RGE

P! ¥ rendaring; RGE rendering may be cho

Ej Render in 8-bit YUY cause intensity or color shifts in rend

High-precision YUV rendering provid:
=y applying multiple effects, or when the
._J Render all YUV material in high-precision YUY hits of precision, but takes longer to

Process Maximum White as:  White 4 ]

This salects how RGE colors are mapped into ¥CrCb Image processing. This option can be sett
whhich produce "brighter than standard” white {also known as super-whitel.

Morion Filtering Quality: Normal | : ]

This salects the filtering quality used when rendaring motion tab motion effects.

Click on the Video Processing tab.

There are three sections to this dialog box. The top third
determines render quality, the middle tells Final Cut how to
handle white level processing, and the bottom third, which is
new in FCP 5, affects rendering of motion effects. Let's take a
look at each one.

Video bit depth



General ' Video Processing ' Timeline Gptions ' Ren|

Always Render in RCE
Render in B-bit YUY

Render 10-bit material in high-precision YUV

CICIET )

Render all ¥UV matarial in high-precision YUy

The radio buttons at the top control the bit-depth that Final
Cut uses to render your sequence.

Video bit depth determines how many shades of black and
white, color, or alpha channel transparency each pixel can
contain. 8-bit video allows 256 different shades of gray, or
shades of a single color, such as red. 10-bit video allows
1024 shades of gray, or shades of a single color.

(Remember that the color of each pixel is determined by the
mix of red, green and blue colors - so in a 10-bit
environment, each pixel can have one shade to 1024 shades
of red, one of 1024 shades of green and one shade of 1024
shades of blue.)

For black and white images, 8 bits is generally considered
sufficient to represent the range of gray scale that is
conveyed in a high-quality black and white photograph.

For color, however, 8-bit video is considered limited,
especially when using gradients or compositing. In these
instances, 10-bit video provides much better images.

Here's how to choose.

e If you are shooting DV, HDV, BetaSP, or DVCPro-HD,
select "Render in 8-bit YUV" because all these are 8-bit
formats.

e If you are capturing using "Uncompressed 10-bit video,"
select "Render in 10-bit..."

e If you are working EXCLUSIVELY with images created on
your computer, for instance, animation, select "Always
render in RGB."

e If you want the highest quality for your compositing and
effects, select "Render all YUV material in high-precision
YUV."

Update: Graeme Nattress notes:

Larry - have you ever seen setting this to "High
Quality" to produce a quality improvement or
difference? I've only seen bugs caused by > 8-bit
render and much increased render times.

Update: Two notes: 1) All render files, regardless of quality,
take the same amount of disk space, and, 2) video always



creates YCrCb images and the computer always creates RGB
images. When you are working with video always work in a
YUV (YCrCb) color space. (YUV is the analog version of video,
YCrCb is the digital form of video.)

Processing white levels

Process Maximum White as: W!
Super-Wwhite |

This selects how RGE colors image processin

which produce "brighter tha:’Mknwn as Super-\

This setting determines how Final Cut handles white levels of
imported graphics. This has NO effect on white levels inside
video clips. (To control those you need to use the Broadcast
Safe filter.)

Updated wording: The default for this setting changed in
recent versions. In earlier versions of FCP, it was set to
"Super-white."” In FCP 5, it is set to "white.” What's the
difference?

When you shoot DV, or create images on your computer, you
are working in a pure digital grayscale space. However,
analog video works in the more restrictive gray scale range
of YUV.

Updated wording: In digital video, black is set to O on the

waveform monitor. In NTSC analog, black is set to 7.5% (7.5
IRE to you video engineering types.) In Final Cut, always set
your black level to 0. (In NTSC-Japan and PAL, analog black

is set to 0.)

Update: Graeme Nattress writes:

It's also good to differentiate between analogue
voltages in IRE and FCP levels in % and not mix
them. The % levels in FCP don't always map to
analogue voltages in the way you'd expect.

Most video formats shoot superwhite. If you have
superwhite video in a white timeline, and do a
dissolve even, you might see a luma shift effect as
the rendered video gets clamped, whereas the rest
does not. This setting doesn't effect video unless it
has a render.

Larry, again: In digital video, white is set to 109%b, while in
analog, white is set to 100%. The problem is when you
broadcast whites that exceed 100%, the image will tear,
edges will ripple, and there may even be a buzz in the audio.

Consequently, you need to make sure that your white levels
don't exceed 100% for anything you create that will be
displayed on a TV set. These white levels are clamped in one



of two ways: for graphics and text, and for video.

Video is clamped using the Broadcast Safe filter. Graphics and
text are controlled from the Video processing tab. Here's an
example.

F ?ldeut Cmr,mls? Filtersf Motion _u
rl.i;'.i;' O0:00:10:00 49%™) BT T | (-ZET 00:00:55:00

Layour: | Waveform = ] Wiew: | Current Frame | ,]

Waveform Manitor

This is the waveform monitor with white levels set to
"Superwhite.” See where the white level on the left exceeds
100%; shooting all the way to 109%7? This far exceeds the
technical standards for your TV set.
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Layour: | Waveform :_1 Wiew: | Current Frame

Waveform Monitor

Here's the waveform monitor with the white levels set to
"White." The image is the same. What's different is that the
gradient has been "clamped," or adjusted, so that the
maximum white level does not exceed 100%; making it safe
to broadcast.

Updated wording: The rule is clear. If you are outputting to
DV or the computer, and never expect to view your work on
a TV set, you can set this pop-up menu to "Superwhite.”
However, if you want to be safe, leave this set to "White."

Motion filtering

Best

Maotion Filtering Quality: Hormal o= !
Fastest linear) v

This selects the filtering q—ring mation tab m

New in FCP 5 is the bottom menu -- motion filtering. This
controls the quality of your renders for motion effects,
including scaling and rotation.

In FCP HD, Apple chose to have everything render in
"Fastest” mode. This provided the greatest speed, but there
were problems with objects that changed in size or rotation.
They wouldn't look as good as they could.

So, with FCP 5, Apple provided two more choices: "Better"
and "Best."

In general, if you are creating motion effects, that is, you are
changing settings in the Motion tab of the Viewer, you will
get improved quality by changing these settings.



Here's the rule: you can set your render settings to "Fastest”
while you are editing your project. However, when you get
ready for final output, change your setting to Best and re-
render.

Update: Tom Wolsky adds:

Tests have indicated there is no real difference
between Normal and Best, and the render hit in
time is pretty big.

Larry, again: Changing this setting will ALWAYS delete all
your existing render files for the currently active sequence.

However, there's a bug in the current version of Final Cut
(5.0.4) that effects this decision. If you add a keyframe for
rotation, even if you only add one, your motion filter settings
automatically reset back to Fastest.

If you are not changing motion tab settings, you can ignore
this. If you are, experiment with these settings to see
whether the improved quality is worth the extra rendering
time. And, remember, rotation keyframes reduce the quality
back to the same level as can be achieved in FCP HD.

[ Goto top ]

Larry's Seminar Tour Comes to Australia!

After a very successful seminar series here in the US, Young
Australia Productions has invited Larry to bring his Final Cut
Pro Seminar tour to Australia. This four-hour seminar will be
at the Mercury Cinema in Adelaide, April 7, 2006. Tickets are
$275 (AUS) and seats are limited.

At this seminar you will discover productivity secrets and
technique you never knew existed in Final Cut -- how to
optimize your system, how to organize your files, how to edit
faster, trim faster and improve your output. All the subjects
have helped editors across the US improve their productivity!

In addition to this seminar, Larry has reserved two extra
days for private staff training. If you are interested in
customized training -- specifically tailored for your staff --
these day-long sessions are perfect. We will be in Sydney,
Melbourne, and Adelaide.

To learn more, to reserve your seat, or sign up for training,
please contact Young Australia Productions Pty. Ltd. for more
information:

Phone: (+618) 8244 7880
Fax: (+618) 8244 7870



Email: info@youngaustralia.com.au

Web: www.youngaustralia.com.au
[ Go to top ]

Technique: Creating multiple keyframes at once

Here's a technique you can use to set motion keyframes in
multiple clips at the same time in a sequence. Then, a
modification of this technique that gives you more control
over the keyframes you set. To do this, we will learn how to
set keyframes in the timeline.

When I'm creating motion effects, I'm working almost
exclusively in the Viewer, so | don't use Timeline keyframe
editing very much. (Actually, I'm being polite. It's been years
since I've edited keyframes in the timeline.)

Still, there are some tricks you can do in the timeline that
just can't be done in the Viewer. And I'm indebted to the new
Apple text book on Advanced Color Correction and Effects in
Final Cut Pro 5 (published by Peachpit Press), which I've
recently been reading, for pointing out the error of my ways.
This technique shows off the power of setting keyframes from
the timeline.

Here's how it works.

B Timeline: Seq - Snowboard Introin Chapter 02 Lesson

Seq - Snowboard Intro |
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I've created a sequence of four clips in the timeline. Let's say
that | want them to all scale to different sizes, but the
scaling all starts and ends at the same time. (By the way,
there is no limit to the number of clips you can use in this
technique, nor do they all have to be the same length. | just
arbitrarily decided to use four.)



Put your playhead where you want the keyframes to be
placed, then select the clips to which you want to apply the
keyframes. In this case, | want to leave the bottom track
untouched, so | selected the top three tracks.

| Add Motion Keyframe - ~K

In the lower right corner of the Canvas, click the "Add Motion
keyframe" button.

. 432
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Anchor Point | 0.

Double-click a clip to load it into the Viewer and notice that
keyframes have been added to every parameter in Basic
Motion, Crop, and Distort. This technique does not set
keyframes in filters, nor in other motion tab parameters.

Modification #1 - Editing keyframes in the Timeline
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In the lower left corner, click on the "Toggle Clip Keyframes"
button to turn on keyframe editing in the timeline. This step
allows you to modify keyframes in the timeline.

Keyframe Editor
Salect All Speed Indicators
Select Mone

Salect All

Salect None

Control+click on the button and Select None to uncheck all
the options, then turn on only the Motion Bar. This step,
reduces the clutter in the Timeline and the amount of vertical
space each track requires.

) [ 01000136 g0

Double-click a clip, in this case | used the top clip, to load it
into the Viewer. Click on the Motion tab and change the scale
to some number other than 100%. In this case, | used 50%.
Notice that in the gray bar below the clip, a blue line
appears. This represents all the motion effects applied to this
clip. Your keyframe is now displayed in the timeline.

—4432




Notice, back in the Timeline, that there are now TWO
keyframes indicated. And, here's the cool part. Using the
arrow (selection) tool, grab the blue line and drag it back and
forth. You are now sliding your keyframes earlier or later in
the Timeline; without going up to the Viewer!

Modification #2 - Setting just one keyframe from the timeline

There is one problem with this approach, however. Using the
"Add Motion Keyframe" button in the Canvas sets 14 different
keyframes (um, | just counted them). That's a lot. It would
be much better if you could just set the keyframes you
needed, instead of everything. You can, and here's how.

Kayframe All

Keyframe All .

+ Scale Scale

¥ HRotation Rotation

+  Center Center

¥ Anchor Point Anchor Point

¥ Aspect Ratlo Aspect Ratio

+ Crop Crop

+ Distort Distort
T T—

First, make sure at least one clip is selected and that the
playhead is positioned where you want the keyframe to
appear. Control+click on the Add Motion keyframe button and
select "Keyframe All" to turn everything off. This screen shot
illustrates the "before" and "after” you select Keyframe All.

@ Keyframe All
Rotation E

Center

Anchor Point

Aspect Ratio

Crop

Distort
T

Now, Control+click the Add Motion keyframe button and
select, in this example, Scale.

Name | Parameters | Mav og:00 01
¥ Basic Motion @ E - *
Seale ey wo| 4(eb &
; 7 432
Rotation - - o 4fe 4
! ;. = -432
1
Centar (+) | ] | ] 40 +*
Anchar Point | o, | ] 40 +*

Make sure the selected clip is loaded into the Viewer and see
that only a scale keyframe has been applied to the selected



clip. This is a GREAT technical to quickly add the same
keyframe, say scale, at the position of the playhead to a
variety of selected clips.

[ Go to top ]

Last month's survey

Last month, | asked you for your opinion on what you are
interested in learning about Final Cut. Over 500 people
responded and I'm delighted with the range of your answers.

Here are the final results of the survey:



What would you most like to learn about Final Cut?

Percent | Votes

Multicam | [ 2% | 76

Color correction | | 7% | 196
Getting organized |[___| 3% 80
How to edit faster | [HNNEENNN 5% | 141
How to trim faster |[____| 3% 79
Output and export |[_] 2% 68
Compression for DVD | [N 6% 170
Logging and capture |[] 1% 51
Motion effects | ] 6% | 160
Keying | I 3% 81

Working with HDV || 4% | 112
Working with HD | ] 3% | 102
Working with 2:;22 | 30, a6
Waorking with film L] 1% 47
Improving capture |[_] 2% 56
Advanced Livetype | NN 5% | 152
] —

Filter effects [ 4% | 123
Mattes and masking | [N 7% 190
Compositing || 4% | 126

File management [[______] 4% 118
cunll:ilzz?’:t?;s B o By
Editing aesthetics |[[_____] 4% | 125
Other | ] 1% 35

Total Votes 505

The top five subjects are:

Color Correction
Mattes & Masking
Compression for DVD
Motion Effects
Advanced Livetype

abrwWwNPRF

Thanks to your feedback, we are already working on
developing new materials that focus on these interests.



This month's survey

This month, I've got something a bit more fun for our survey.
I'm interested in learning what significant Final Cut feature
you use the LEAST.

Now there's lots of arcane stuff that very few people use --
but this is a list of 17 major features. You get to pick up to
five that you use the least.

Click here to take the poll:
http://www.pollmonkey.com/p.asp?U=4013427642

As usual, you can see the results of the poll as soon as you
vote -- or whenever you look at the poll on my homepage
after voting.

And thanks!
[ Goto top ]

Technique: What is Frame Offset?

Recently, on the Apple Trainer's list-serve, a debate started
about the function of Frame Offset.

According to Apple's FCP 5 manual:

No matter what signal format you use for external
monitoring, all digital video and audio interfaces
(including FireWire) introduce inherent processing
delays (known as latency) to signals sent out of the
computer. External video and audio coming from
the built-in FireWire port or third-party interface
may be several frames later than the video on your
computer display (in the Viewer or Canvas). The
latency, or offset, between different devices can
make precise editing difficult.

By changing the frame offset value in Final Cut Pro,
you can compensate for the delay between your
computer display and external video and audio
outputs. Frame offset is active only when your
sequence real-time effects are handled by Final Cut
Pro



System Settings

Scratch Disks '/ Search Folders ' Memory & Cache ' Playback Control ' External Editors ), Ef

Playback
RT: | 5afe f t] " Play Base Layer Or
Video Quality:  Dynamic (&= ] ¥ Beep When Playint
Frame Rate: Full f t] ™ Scrub High Quality
Pulldown Pattern:  2:3:2:3 -:] W Multiclip Playback
Gamma Correction:  Accurate ]

Frame Offset: [ 4

Note: The video guality and pulldown capabilities for a particular sequence are based on
KT popup in the Timeline for the capabilities of a particular sequenca.

To view, or change, your Frame Offset, go to Final Cut Pro
> System Settings and select the Playback control tab.
Half-way down the screen is the default setting for the Frame
Offset of 4 frames.

Now, here's the important part. Changing the Frame Offset
changes how long Final Cut delays displaying video and audio
to your computer. It does NOT change any output sent
through your FireWire port.

In other words, if you are watching video both on your
external monitor and on your computer screen, and they are
not in sync, changing the Frame Offset delays your computer
screen to match your external monitor, based upon the
number of frames entered in the Frame Offset. This is the
opposite of how Avid handles these delays. On an Avid,
changing the Frame Offset changes the delay to the external
monitor.

Prior to researching this, my understanding of what was
being delayed was incorrect and | wanted to share this
revised information with you.

Martin Baker, from Digital Heaven in the UK, further
comments:

However the Frame Offset setting is not useless if
your monitoring is set up in the right way. As your
original article says, it is crucial that the audio is
monitored from the SAME point as the video.
Therefore if you have an external FireWire
converter or camera feeding a video monitor then
you must also use the audio feed from that device
for everything to be in sync.

Larry replies: This is why | recommend that my clients add
an audio mixer to their editing suite, so that they can easily



switch their speakers from monitoring the audio from their
computer to monitoring the audio coming from the deck.

[ Goto top ]

Technique: Using Media Manager
to get rid of unused media

This technique sprang from a request from Reid Kramer, who
wrote:

I was wondering if there is an article about using
FCP 5's media manager for consolidating your
projects. Basically for getting rid of unused footage
to shrink your projects file size.

There have been many posts on 2-pops site about
this and there seems to be a problem in FCP 5.
Most users have said that it worked fine in FCP 4.5,
but now in version 5 it does not work correctly. |
have heard one user say that you need to make
your sequence or your clips (independent clips).

If you could explain this to me it would be great
thanks.

Larry replies: Unlike other features in Final Cut, the Media
Manager is not your friend. It is neither intuitive nor stable.
My recommendation is to avoid it whenever possible.

Media Manager has not been significantly improved since
back before the dawn of time and everyone who uses it has
"issues" with it.

For this reason, | recommend not capturing whole tapes, but
capturing clips in segments, which makes deleting individual
clips easy, without using Media Manager. | also created my
Final Cut organizational system (detailed in this article) so
that you can easily archive projects and trash media, without
ever resorting to using Media Manager.

However, sometimes, Media Manager can't be avoided. This
technique shows you how to remove unused media from your
project.

First, though, a huge warning: Deleting unused media from
your capture files means that Final Cut will be copying and
deleting clips from your hard drive. This process takes a
potentially very long time. If you have a power failure, or a
crash, your files can be left in such a disorganized state that
you are not able to use them.

As Apple's manual says:



Be extremely careful when choosing the “Use
existing” option; the Media Manager deletes each
media file as soon as it finishes processing it.
Canceling this operation may restore the media file
currently being processed, but media files that have
already been processed cannot be restored.

With that warning, here's what Media Manager does.

You select a clip, clips, sequence, or group of sequences to
media manage. Using Media Manager to delete unused media
will create a new project containing all the clips and/or
sequences trimmed to only include the media you are
actually using. Then, Media Manager goes into your capture
files and permanently deletes media from the media clips
stored on your hard disk that is not used in the newly
created project.

In other words, if you use the same media in different
projects, Final Cut only pays attention to how you are using
the media in the sequences you selected. Or, if you use the
same media in other sequences in the same project and
those sequences were not selected, any media used in those
unselected projects will be ignored and deleted.

Here is a specific example. | have created a project that
contains two sequences. | want to delete all media that I am
not using in either of these sequences.

aaa8 Browser
Chaprer 02 Lesson | Effects

B -] seq - snowboard Act 1] |00:00:03:07

-] seq - Snowboard intro | | 00:00:29;20
B[] Ein1

Elue sky |00:00:12:16

Down mountain | 00:00:14:22

Fan tail |00:00:08:11

1) Most importantly, BEFORE starting Media Manager, select
the sequence(s) you want to media manage. Here, I've
created two sequences: Seq - Snowboard Intro and Seq -
Snowboard Act 1 and I've selected both BEFORE starting
Media Manager. This step is critical!



Media Manager

Summary:

Create 2 new project oontaining the iteens you kave selecoed. Delete unuted media from the duplicased
mams, including mada relerenced by alfiliaes clips outside the seletion, Use axisning medis files
referenced by the duplicated Eema, incliading render Rles

oo | ' v
wesoes. R+ v

or ower bar graph for more informationy

Copy
1 Move
Recompress
T] media referenced by duplicated items.
| Create offline ™|
T—

o

# Delete unused media from duplicated items.

_| Use Handles:

aw

Base media file names on  existing file names

=

Project:
# Duplicate selected items and place into a new project.
# Include nonactive multiclip angles,

Media Destination:

Cancel ) ok )

2) Select File > Media Manager. Then select Use existing
from the pop-up menu. This tells Final Cut that you want to
delete all media that you are NOT using in the two selected
sequences.

™ Delete unused media from duplicated items.

™ Use Handles: | 00:00:03;00

v le affiliate clips outsi election

3) Then, just in case, check Use Handles and give yourself
some pad in case you need to trim a shot or add a dissolve. |
generally use either 3:00 or 5:00.

~ Project:
# Duplicate selected items and place into a new project.

! Include nonactive multiclip angles.

4) Duplicate selected items... means that Final Cut will
create a new project and put the items you've selected into
the new Project. This is generally a good idea, that way, your
old project remains untouched in case you need to recapture
a clip that got deleted by mistake.

Include nonactive multiclip angles means that Final Cut
will include clips that are part of a multiclip, whether they are



used in the selected items or not. My feeling is that checking
this is a good idea if you are using multiclips, because you
can't rebuild a multiclip if there's a break in timecode in the
middle of a clip. If you don't use multiclips, leave this
unchecked.

(mowe your cursor over bar graph for more information)

5) The bar chart at the top indicates how much space you are
saving with this procedure. Your numbers will be different.
Keep in mind that you are often dealing with hundreds of
gigabytes of files. This process will take a long, long time to
get everything copied. Don't be impatient -- give your Mac
time to work.

Save

Save As: Managed project ¥ ':q

Where: | FCP Projects e !

Format: Project File

(. Cancel ) ( Save \j

6) When you click OK, Final Cut displays a dialog asking you
to name your new project and find a place for it to be stored.
I always store my Final Cut projects in the FCP Projects
folder.

Additional Items Found

6 items outside of your current selection have been found to reference media about
to be processed during this operation.

No additional disk space will be reguired if you add these itams to your selection.

If you select Continue, these items will not be added to your selection, and they
might be taken offline.

I;’ Add 'JJ L';Euntinue:,l ( Abort :j

7) This dialog drives me nuts. None of these choices make
intuitive sense. So, here's what they mean, according to the
Apple manual:

Additional Items Found dialog: When you use the
Media Manager to do a potentially destructive
operation, Final Cut Pro checks all currently opened



projects to see if there are any other clips that
reference the same media. If so, the Additional
Items Found dialog appears.

Add: Click this button if you want to tell the Media
Manager to consider additional portions of media
files referenced by other currently open projects.

Continue: Click this button to continue the Media
Manager operation without taking into consideration
the additional portions of media found. This may
make some clips offline in projects outside the
current one.

Abort: Click this button to stop the Media Manager
operation (for example, if you want to change your
original selection). Decide what you want to do,
then click a button.

My recommendation is to err on the side of safety and click
Add if this dialog appears.

i Confirm Media Medifications !

WARNING: This operation will permanently modify
existing media files. This is not undoable, and any
open projects referencing these media files will be
saved.

{ Abort |} (Continue}

8) Final Cut then displays one last warning that what you are
about to do is not undoable. Click Continue if you are
determined to proceed.

F =

Processing Files...

Writing Down mountain

Estimated Time: About 5 seconds

7 Y S— |  Cancel )

9) Final Cut then goes thru all your selected items and
removes media. This process can take a while, so it displays
a progress thermometer.

10) On my dual G-5, I started timing how long the process
would take -- except that after it got done processing two
clips -- about 22 seconds in -- Final Cut crashed.

Sigh...
So | tried it again and it crashed again.

Then, | tried again, but clicked Continue rather than Add.



Crashed again. (I am using Final Cut Pro 5.0.4 on OS
10.3.9.)

I decided to take this as a sign that |1 should not use Media
Manager to remove unused media from a project.

Others tell me that Media Manager will remove unused media
and that this is the correct procedure. However, this just
illustrates my bigger point -- avoid using Media Manager by
capturing smaller clips, rather than relying on Media Manager
to remove media once you've captured it.

Update: However, not everyone hates Media Manager. I'll
start with comments from Kees-Jan de Maa:

As you know, [from our conversation in Austin] I
enjoy the Media Manager and | guess mainly
because it keeps us so organized. We also do 2-3
camera shoots, tapes are running all the time, than
capture. so the rough edit and directly use the
Media Manager. By that tie we have renamed all
clips in the media bin and all is cut down to what I
really need. Saves me a lot of space.

Tom Wolsky continues:

[Your comments on Media Manager] may be unfair.
I think it's been improved in every version of the
application. There were improvements made in v5
and further fixes in the point updates subsequent to
that. One problem I think is that people aren't
getting the results they expect because of how
they're media managing, what they're choosing to
manage, and what settings they're picking in media
manager.

To be honest | would not use the Use Existing
function. It's too dangerous, even more so than a
potential power failure. | would use the Copy
function if | had the drive space, then dump the
other files after I've confirmed the media is correct.
Or I'd use the move function, and then dump the
other files. The important one to make sure you
have unchecked is the include master clips outside
of selection.

Loren Miller, of KeyGuide™ fame, writes:

I think you are unusually harsh on Media Manager!
Trimming may still be problematic but archiving is
great.



Using COPY in FCP HD (4.5) , | just safely archived
a project-- not a sequence, the whole project-- to a
FW 800 archive drive which had DV, TIFFS, AIFF's
and render media spread out over four different
external and internal drives. The collected, archived
project preserves all files and plays perfectly.

In fact, | generated a reference movie and burned
the final sequence in it to DVD.

Larry replies: Thanks for all your comments.

[ Goto top ]

Technique: Creating and Using a Soundtrack Pro script

This technique occurred to me while | was developing a
training DVD for Lynda.com on Soundtrack Pro because
scripts in Soundtrack Pro have a quirky behavior that
surprised me until 1 did some research on them.

Here's a scenario. | have a sequence containing several
talking-head interviews. The audio is low on all of them. An
excellent way to boost audio is to normalize it, which is a
feature FCP doesn't have, but Soundtrack Pro does.

(Normalization is an audio process that increases the audio
gain, or volume, of a clip without running the risk of
distorting the clip's audio. Normalization is much better than
grabbing a red rubber band in FCP and dragging it, because
when you drag to increase the volume of a clip, there is
always a risk that you have increased the volume too much
and distorted your mix.)

What scripts can do is automate adjusting the volume, or
other audio parameters, across multiple clips with a single
mouse click.

L‘J oL:00:02.28 {00700 OL:G0:0F 00 01:00:; 14,00

®[iv) a
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F N F e, il
G;} ' g o= |-Easley- %! safe g pmapunsl Jemill - 8ig thrad; Myers - Flooding gegl——
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Here's a sequence containing three interviews. (Scripts can
work with any number of clips, | just selected three to keep
things simple.)



Open "Easley - Get safe’
Open in Editor

Reveal in Finder
Duration (0Q:00:06;28)...
Make Independent Clip
Itam Froperties

"Motion” Praject...
Soundtrack Pro Audio File Project .
Soundtrack Fro Multitrack Project ™
Soundtrack Pro Script [

Copy

Control+click a clip, in this case the first one, and select
Send to > Soundtrack Pro Audio File project.

r = |
Save

Save As: EE,?[SEE',I’ - Get safe (sent) B

Where: : | FCP Projects Hr-]

(Cancel ) m

Soundtrack asks you where you want to store the audio
temporary file it creates as part of this process. | recommend
storing these temp files in your FCP projects folder. (Click
here to read an article on how to organize your FCP files.)

Soundtrack opens and displays your clip. Press Cmd+A to
select the entire clip.

MWEW Window # Help

Effects [
Fade In

Fade Out

Adjust Amplitude... ! {ra36L

Silence |




Then, go to Process > Normalize and normalize your audio.
(Click here to read my article on how to normalize a clip.)

MNew >
Open... F#0
Open Recent >
Close Window i W
Close Tab HEW
Save ##5
Save As... i 385
S5ave a Copy As... ~ 35

S5ave As AppleScript... |

Export >

So far, this is is nothing unusual. But, before you save the
file, go to File > Save As Applescript...

Save As: Lr'l_qzmalize clip t E]

Whe | Soundtrack Pro Scripts

&

. and give your script a name. In this case, | called it
Normalize clip. (Here's an important tip -- don't change the
default folder Soundtrack suggests to store this script in. FCP
only looks in this folder to see what scripts are available.)

New [ ]
Open... F#0
Open Recent [ ]
Close Window FEW
Close Tab

Save As... 1+ 3ES
Save a Copy As... 35

Save As AppleScript... (35

Export >

Save your audio file project and switch back to Final Cut.



Timeline: Seq - scripts in script test
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Now, here's where scripts earn their keep.

Make INgepenaent Lip
[tam Properties 3 -"l
"Motion” Project...
Soundtrack Pro Audio File Project
Cut Soundtrack Pro Multitrack Project
Copy Soundtrack Pro Script
Last Soundtrack Pro Script
Shake

Remove Attributes... P ———————————

2_12 fade in
normalize clip |

Select each individual clip (one clip at a time) and choose
Send > Soundtrack Pro Script = Normalize clip (or
whatever you named your script).

Final Cut sends the clip directly to Soundtrack, which
normalizes the audio, and sends the clip back to Final Cut. All
automatically and in just a few seconds. This is a very fast
way to make rapid adjustments to a whole flock of clips.

Warning

However, there is one large gotcha' to worry about. Scripts
work great when you select the entire clip to process. Where
things break down is when you do something, such as a fade-
in, that only modifies part of a clip.

In this case, when you save the script creating a two-second
fade-in for a ten-second clip, Soundtrack DOESN'T say, "Add
fade-in for first two seconds."” Instead, Soundtrack records
the script as "Add fade-in for first 20% of a clip.”

So, let's say the next clip that you send to Soundtrack for a
fade in is a 20 second clip. Instead of adding a 2 second fade
in, which is what you created, Soundtrack adds a 4 second
fade in, because that's 20% of the length of the clip.

Boy, did THAT surprise me the first time | ran into it!

So, to prevent unexpected problems, be sure to select and
process entire clips when you plan to save your results as a
script.



Update: Lisa Brenneis writes:

I did post-production audio for years, and | have a
mild panic attack every time | think about FCP
users out there blithely applying STP scripts to their
audio tracks and discovering later that STP scripts
modify the original audio media file and then save
the changes.That's usually such a bad idea,
especially if you plan on handing your audio off to a
sound specialist.

FCP was designed as a non-destructive editing
application and this glaring exception to the "no-
destruct” rule is one of those Apple mysteries...
anyway, | wish you would warn Newsletter readers
that the STP script option will overwrite their
original audio files.

OK, deep breaths....

Larry replies: Lisa, you are absolutely correct and | forgot to
mention this. Using a script permanently changes your
master file on disk, unlike an audio file project which is,
generally, non-destructive. You provide an excellent caution.

Update: Before we change the subject, though, Anders
Elverhgy, from Norway, hastened to chastize me for even
mentioning normalization:

In the audiobiz the golden rule is "no
normalization”. The reason is simple, it sounds bad
and destroys your sound. Since people in video
mostly work with 16-bit sound, you will instantly
run into rounding errors, they sound bad.
Normalization will give you hard, unpleasant audio.
It's much better to insert a gainer plug-in and grab
those red rubberbands and work your compressor. |
know this isn't the video editor's dream, but there
IS no way around.... sorry...

Larry replies: Anders, when working in music you are correct,
normalization often makes music sound unnatural. However,
when working with interviews where the audio wasn't that
great to begin with, normalization can bail you out of some
difficult situations. If there's time, next month I'll show you a
different way to control audio using a Limiter filter.

[ Go to top ]

Reader Mail
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Reader mail is especially large this month, so I've moved it to it's own page.
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Subjects

Problems repairing disk permissions
Surround Sound

New audio product

Resync'ing audio files

Syncing timecode

Improving Speed Changes

Exporting individual clips

Exporting still frames

Exporting OMF files

Stair-stepped text

Still image quality

Countdown timer

Differences in diqgital formats
Converting mono to stereo sound
The secret to sending to Soundtrack Pro
Optimizing your processor speed
Getting Cinewave to work with FCP 5
Upscaling SD to HD

Wrap-up

Problems repairing disk permissions

Cedric writes:

My system froze and | had to re- start my computer.
I trashed my preferences and | tried to run the
"repair permissions" but | keep getting this error
message (see attached).

Every time | try to restart, the same message
appears. What should 1 do?

Larry replies: Not to panic. This is a problem with iTunes 6.0.2
and 6.0.3, but not the current version of iTunes.

The culprit is an iTunes file: iTunes.pkg. There's a series of



iTunes files in the LIBRARY>=RECEIPTS folder but only one of
them seems to cause problems by breaking communications
between the Disk Utility and Disk Manager. Once you trash the
iTunes.pkg file, you should be able to run Disk Repair program
without a hitch.

[ Go to top ]

Surround Sound

Forrest Fox, in Minneapolis, writes:

Right now, I'm trying hard to find some advice on
just how to set up for editing in, and ultimately
mastering 5.1 surround sound. Audio interface?
Additional software? Monitoring? Practical systems for
delivering commercial quality product. Money, is of
course, an issue. Where do | start?

Larry replies: As of now, there is no way to author 5.1
surround sound in either FCP or Soundtrack Pro.

ProTools TDM supports this, as do other applications. If a
reader has a favorite software for creating 5.1 surround, I'd be
interested in sharing that with others.

[ Go to top ]

New audio product

Andres Kiel, our XML wizard, has a new utility called Sound
Count. This is, as he writes, a fast and easy way to calculate
the total playing time of commercial sound in a sequence or
project. This is especially useful for calculating usage rights or
royalties.

You can learn more about it here:
http://www.spherico.de/filmtools/SoundCount

[ Go to top ]

Resync'ing audio files

Rudy Picard writes:



-u.m-u.i-&u.u.m
o
o

i
7

I ran into this weird editing occurrence in Final Cut
Pro. The image should show two audio tracks which
are out of sync. The problem is that they're stereo
tracks. So | can't simply unlink them then put them
back in sync. | also tried disabling the linked
selection option on the timeline, but with no luck.

Larry replies: Resync'ing is easy if you know the secret key.

First, you need to switch the audio clips from stereo (indicated
by the green "bow-tie™) to dual-channel mono. You do this by
selecting the clip and choosing Modify > Stereo (or pressing
Option+L)

Second, Control+click on the red flag of the top clip and
select "Move into sync.”

Third, reset your audio clips back to stereo by selecting both
channels of the clip and typing Option+L.

[ Go to top ]

Syncing timecode

Wolfram Grotzner, from Germany, writes:

[One of your readers asked how to sync audio with
timecode.] | would suggest making an Aux TC at the
frame of the sync-slate.

But how is it possible to use a recorded TC from an
audio channel as the Aux TC?

I suggest they look at TimeTool:
http://www.gallery.co.uk/timetools.html

Larry replies: Another great tip. Thanks.

[ Go to top ]

Improving Speed Changes

Matthew London writes:



May | pick your brain for a second? I need to slow
my footage down with best possible quality (mostly
just 50%, no variable motion.) Uncompressed 10bit,
eventually converting to HD.

Is Twixtor (http://www.revisionfx.com/rstwixtor.htm)
still the only way to go? It is horribly complicated

and expensive, but I'll bite the bullet if there are no
other options.

Larry replies: If you are not happy with the Modify > Speed
changes that Final Cut provides, then a plug-in will be
necessary.

I do not have any personal experience with Twixtor, but I have
heard of Re:Vision.

Keep in mind that Twixtor does not support 10-bit video, only
8-bit, so there will be some downsampling involved. Also, if all
you are doing are speed changes, you don't need the PRO
version.

Finally, $330 for a plug-in, or software, is not that expensive if
it's the only way to solve your problem. Try downloading their
demo and see if it meets your needs. Then, let me know the
result.

[ Go to top ]

Exporting individual clips

Ed Baron writes:

This is probably too simple, but I can not seem to
save segregated clips.

For example, I have had some 8mm movies digitized.
The problem is that the clips that were made are not
separated correctly. | load the mixed clips into FCA,
put them in the time line, cut them with the razor
blade, separate them so there is black in between.
Now, | would like to save the separated clips
individually. They seem to save with all the frames as
the original clip.

Larry replies: You need to do this on a clip by clip basis.

Edit your clips on the timeline

Set an In and Out for each clip you want to export
Choose File = Export > Quicktime movie

Make the movie self-contained and save it somewhere you
can find it later

e Re-import these exported clips and you're all set.
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Exporting still frames

Kathleen McNamara, from San Francisco, writes:

What I'm looking for is information on how to export
stills created in FCP into PhotoShop and work on
them there to improve the image quality. Basically, |
want to make a still photo out of a single frame of
video.

Larry replies: First, keep in mind that video is EXTREMELY low
resolution. You can't enhance what's not there in the first
place.

To export a still use File > Export > Quicktime Conversion
and set the file type to "Still image."

Load the image into PhotoShop and rescale it, using lmage >
Image Size. Make sure to turn "Constrain proportions" turned
off, then resize it to 640 x 480 x 72.

From there, you can edit it as any other digital image.

[ Go to top ]

Exporting OMF files

Ken Stone brought an error in my article on OMF export to
my attention. Ken wrote:

I have been reorganizing my web site
(www.kenstone.net) and when | came to your
Technique: Exporting Using OME article |
remembered that | got several comments about one
paragraph. 1 have been told by several people that
‘using In and Outs' does not work to limit the export.

Do you have any new information on this?

Larry replies: Ken, | just did a quick test and exported a 6-
track sequence to an OMF file three ways:

e The complete sequence, including all tracks

o All tracks, but setting an In and Out so that only the first
half of the sequence was flagged for export

e Exporting only the first three tracks by turning off the
visibility lights on tracks 4, 5, and 6.

On reviewing the exported OMF files:

e The Complete track export and the In/Out track export
were the same size



e The OMF file that was only the first three tracks was half
the size of the first two.

But, says | to myself, maybe this is an artifact of how OMFs
are created. So | fired up ProTools to verify the results. Here's
what | learned:

e Setting an In/Out has no effect on what gets exported.
OMF always exports the entire timeline

e Turning on/off visibility lights does have an effect on what
gets exported. Only those tracks who's visibility light is lit
will be exported.

Thanks to Ken, | immediately revised my article and wanted to
let you know about this issue as well.
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Stair-stepped text

Lindsay Cornick writes:

I am wondering if you know why, when you add a bit
of text, say over black ( | even tried it over a slug ),
center it etc as you describe so well, that it all looks
nice and sharp until you render it ! (it is
green/preview ), then it looks shocking, jagged
edges and really fairly different to the un-rendered
version.

Larry replies: First, text will always look stairstepped if you are
not looking at the Canvas or Viewer at 100% size.

Second, video is bitmapped, not vector, which compounds this
effect.

Finally, video is MUCH lower resolution than your computer
monitor, which also increases the effect.

In other words, stair-stepping is normal, which is why you
need to use fonts which are heavier and less fancy than you
would use in print or on your computer. (One of these days, I'll
write an article on how to select fonts that look good on
screen.)

[ Go to top ]

Still image quality

Sue, from Boston, writes:

I am currently running into a problem that no one
has been addressing. It has to do with importing still
images - they are crystal clear when | import them,



but when they are on the timeline and the playhead
is moving, they blur. when i hit the space bar, they
clear up. this doesn't sound like a square pixel issue
- i've tried that anyway.

They are wedding pictures a client has given me to
add to the beginning of the video I am working on.
She supplied them on a cd : they are all about
2,000x1,312 pixels, 72 DPI.

Larry replies: This isn't a problem -- its a feature of FCP; and
video.

Video images are only 720 x 480 x 72 -- which is a fraction of
the size of the original wedding photos. Video is notorious for
having low image resolution.

As well, you need to separate in your mind the difference
between viewing the timeline for editing and viewing for final
output. FCP always decreases the quality of images during
editing, to allow more CPU cycles for real-time effects.

However, it will render all images at the highest quality video
will support (that 720 x 480 number we were talking about
earlier) prior to output to tape so that your final output looks
great.

This rendering can be done by you, or automatically by FCP --
the results are the same. So, while your final video output
won't look as good as the source photos -- because video has
about eight times less resolution -- they will look as good as
they possibly can.
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Countdown timer

Carlos Borges writes:

Do you know of a way, either in FCP or maybe via a
plug-in, that | can place a countdown timer in the
bottom corner of my video? This is for the purpose of
showing the time during a mixed martial-arts fight.
Basically, they have 5 minute rounds and I'd like to
flash the time left in the round occasionally.

There might be a simple solution, but I've never had
to generate one.

Larry replies: Carlos, There's nothing in FCP that does it
automatically.

What I've done, in the past, is to create a series of text clips,
each containing a number, superimpose them into a black slug,



and export them as a self-contained QuickTime movie. | then
reimport the Quicktime movie and superimpose it on my
timeline.

Update: Andreas Kiel writes:

There is a plugin from Digital Heaven.
(http://www.digital-heaven.co.uk/)

But there is an option to build one within FCP:

e Create a new sequence and select some
generator, a text one without text, a masked
out slug or maybe an imported logo or
animation for the counters background - don't
forget to delete audio tracks, if there!

e Now set the In to O and the Out to whatever
time you want to start the count down - or even
much higher. You may have to change the
duration of the generator manually.

e Apply the "Timecode Reader".

e Uncheck "lIgnores Opacity".

e Set "Opacity"” to O - or a value you may want to
have for the background.

e Adjust "Center" - and color maybe.

e If you want to get rid of the frames, open the
clip in viewer, select the "Motion" tab and adjust
the "Right" crop - but this will also cut the
background, if you decided to have one.

e Now use "Sequence -> Nest Item(s)..." and
name it "My counter” or something like that.

e Apply "Speed -> Reverse" to it.

e Drag the clip to the browser or a bin - or export
to QT with an alpha capable codec, and re-
import as you suggested.

Now you can use the counter anywhere in your
sequences.

The above described method has a nice advantage -
if you think the style of your counter needs to be
changed, you only have to do it in the "Master" once.
And as always, you can export it as XML to use it in
multiple projects, with the option to make individual
changes in the project itself.

There are many other options with the "Timecode
Generator" as well, for example you can use that one
and select the "Frame" option, and set a "Pre Speed
Change" so that one frame will last a second, or
minute.

Tom Wolsky adds:

TMTS has a free timer generator. It's come with



some editions of my book.

Larry adds: Thanks, Andreas and Tom.

[ Go to top ]

Differences in digital formats

Bill Lynch writes:

A basic question for your newsletter from a novice.
What is the difference between the Data Digital
format that allows editing in FCP and the Video
Digital format. One hour of video data is 13 GB and
would require three 4.7 GB DVDs to contain whereas
2 hours of Digital Video can be burned onto one 4.7
GB DVD via a Firewire connection.

It seems Digital Video takes up no more space on a
DVD than Analog Video does. If both the Data format
and the Video format are digital, the Video has to be
captured into FCP and then printed back to Video
after editing, what is going on here with the 0 and
1s?

Larry replies: Bill, just because it is digital does not mean
there is no difference in quality. There are many, MANY digital
video formats. Some are totally uncompressed with incredible
quality. Others are stupendously compressed, with many
compromises in quality.

Totally uncompressed standard definition (i.e. not high-def)
video is about 109 GB per hour. Digital Betacam requires about
96 GB per hour to store. Digital Video (i.e. miniDV) requires 13
GB per hour to store. MPEG-2 video for a DVD requires about
2 GB per hour to store. Each of these is listed in order of
decreasing quality.

The differences are in how each handles resolution, color data,
motion, video compression, and a host of other technical
attributes that all contribute to the overall look of the video.
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Converting mono to stereo sound

Klaus Hanusa, from Berlin, writes:

Now | got a problem: I'm edited a film which was
transferred from 16mm original material (including
with mono optical sound), but when | put the QT
material into the FCP timeline | got the mono sound
only on the left channel, the right channel is empty.



But later | add also stereo based music on the
beginning of the film and at the end.

So, the problem is, how to get a stereo/mono mix
and how do I get the mono track left to the right
track? Because | wanted later on for DVD the mono
track at least on both channels playing!

Thanks again for your kind help.
Larry replies: Simple.
Double-click the mono audio clip to load it into the Viewer.

Drag the Pan slider to the middle. This pans the audio so that
it sounds equally from the left and right speakers.
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The secret to sending to Soundtrack Pro

Markus Wernig, from LA, writes:
In your recent issue, Lou Dullien wrote:

I'm having a problem sending audio clips to
Soundtrack Pro in order to do noise
reduction. I've watched and downloaded
the QuickTime tour of Soundtrack Pro that
demonstrates how to do this, off of the
apple site. The only problem is, when |
control click on the audio clip, my only
option for sending it to Soundtrack Pro is:
"Send to soundtrack pro multi-track.”

I can't figure out why | can't send to
Soundtrack Pro audio file. | think this is the
reason I'm not getting the same results as
in the QuickTime tour. HELP!

Here's a second way to solve this:

If you have a dissolve on your audio clip and both
the clip and the dissolve are highlighted before
control-clicking, you'll only get the "Soundtrack Pro
Multitrack-Project™ option. If just the clip is selected
and NOT the dissolve, both Soundtrack Pro options
are available.

Larry: 1 like this tip, thanks!
[ Go to top ]

Optimizing your processor speed



Gary Hughes writes:

After reading "Optimizing your Processor" from
Andrew Ficklin, and your reply, ("My recommendation
is to set it to Automatic if you have a G-5, and set it
to Highest if you have a G-4."), my question is this:

| have a G5 dual 2.7 AND a 1.67 PowerBook. | do a
lot of work on my PowerBook, including FCP logging
and basic editing, Photoshop, and simple stuff in
Motion, STP, After Effects, DVDSP, Dreamweaver... |
also use the PB for non-creative work, such as email,
web browsing, word, iTunes and Reversi (did | say
"work"?). Would you still set the processor to Highest
on my PowerBook?

860 Energy Saver =
w6 3

Show All Di.spla.',rs Sound Metwork Startup Disk
Settings for: Power Adapter T‘

Sleep = Schedule | Options ]

Wake Options

| Wake when the modem detects a ring
Wake for Ethernet network administrator access
Allow power button to sleep the computer

Other Options

| Restart automatically after a power failure

Processor Performance + Automatic B .

Reduced
" Show UPS Status in the menu bar

[end |

Larry replies: You can change your CPU setting in System
Preferences > Energy Saver > Options tab. You can also
change it when you need different levels of performance. If
you don't need a lot of processor power, go back to Energy
Saver and reset it.

However, when I'm editing, or doing other power tasks, | set
my G-4 to Highest.

[ Go to top ]

Getting Cinewave to work with FCP 5



Rick Lavon took exception to my saying the Cinewave card
would not work in FCP 5. He writes:

While you are correct that the Cinewave card is no
longer supported or made, it does indeed work with
Final Cut 5.0.4 and OS 10.4.4. | have been using it
for about 8 months in this configuration and I am
outputting a half-hour uncompressed broadcast show
weekly. Here are some tips and tricks that worked for
me.

I installed a new drive and left my original drive
alone. | took out the Cinewave PCI card, | then did a
fresh install of Tiger. then did the updates to get it to
10.4.4. Then | upgraded to Quicktime 7.03. Then
installed Final Cut Pro, then installed the Cinewave
card, software and updates. Make sure you update all
your peripheral devices like USB-Serial cards and
SCSI or Fiber cards. Finally repair all permissions at
least twice and reboot.

I find it is more responsive and less prone to crashes
now then before. I know | will eventually have to
trade up to an AJA card, but it is not correct to say it
does not work.

Larry replies: Cool. Please remember, though, that this is an
unsupported use of the card.
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Upscaling SD to HD

Uli Plank, from Germany, writes:

Larry, while FCP 5 is doing a decent job when set to
best rendering quality for the motion tab, |
recommend PhotoZoom Pro for the job.

(http://www.benvista.com/main/content/content.php)

It'll do batches of more than 1,000 frames and does
a pretty advanced upscaling, trying to preserve
edges while avoiding stairstepping. FCP upscaling will
just look soft when compared to it.

Larry replies: Thanks.

[ Go to top ]

Wrap-up

Well, that wraps it up for this issue of the newsletter. The next
edition will be released after NAB, so | can cover whatever
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happens there. We've got some exciting stuff planned for the
next few months and I'm looking forward to telling you about
it.

In the meantime, please buy one of our newsletter
back-issue CDs. Over 560 pages of great tips than
can make you a whole lot more productive for not a
lot of money!

Or, join us for our Australian tour in April. Contact

Young Australia Productions to learn times and
schedules.

Also share your opinions in our monthly poll. Click

here to vote: http://www.pollmonkey.com/p.asp?
U=4013427642

Finally, I'm grateful for all your comments and questions. |
love hearing from you and when you share your ideas and
suggestions, we all learn.

Thanks and edit well.

Larry

Subscribe to Larry's FREE Monthly

Final Cut Pro Newsletter!

Email: o

[ Click here for a printer-friendly PDF version of this issue. 1.3 MB ]

Legal Notes

The newsletter is free -- but does require a subscription. Please invite your friends to sign up at
www.larryjordan.biz.

To unsubscribe, simply send me an email and I'll remove you from the list. This list is not sold,
rented, or bartered. The only person who knows you are on this list is me.

The information in this newsletter is believed to be accurate at the time of publication. However,
due to the variety of possible system and software configurations, the author assumes no liability in
case things go wrong. Please use your best judgment in applying these ideas.

The opinions expressed in this newsletter are solely those of the author. This newsletter has not
been reviewed or sanctioned by Apple or any other third party. All trademarks are the property of
their respective owners and are mentioned here for editorial purposes only.

Text copyright 2006 by Larry Jordan & Associates, Inc.. All rights reserved. This newsletter may not
be reproduced or published in any way, in whole or in part, without specific written permission

from the author.

Links to my website home page, or articles, are welcome and don't require prior permission.

Go to Top of Page Go To Larry's Home Page Send eMail to Larry





